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1. General Information
1.1. Introduction
Welcome to Sierra States University! We are so excited to have you in one of our
various programs and our greatest desire is to see you succeed. We have, therefore, put
together this handbook, which hopefully contains a plethora of aids to assist you to that end.
If you can’t find an answer to a question about something, please let us know and we will
add the information to our next edition of this document. An orientation video has also been
created for you to become familiar with SSU and the Populi program, where you may access
your grades, account information, and course information. Populi is also the learning
management system (LMS) that SSU uses for the online portion of all of its courses.
Every class will include a Paper Template in which all of the formatting standards are
already set up. You must use this form for all papers you submit to SSU. This template can
be found on the “Info” page in Populi under the “Files” section where you can also find the
course syllabus. The template includes a chapter for each of the four requirements for each
course (book reports, quiz, discussion, and self-evaluation). It also includes the proper
format for the title page, table of contents, and bibliography/references. Details for how to
use each of these sections are contained in this handbook.

1.2. Vision
Sierra States University (hereinafter referred to as “SSU” or “the university”) looks beyond
itself to embody the commonly-held vision of an international network. SSU serves and is
served by a large international network of urban leaders, and our vision is shaped by
these networks and partners. The vision of SSU includes the following key components:
1.2.1.Emerging and Experienced Transformational Leaders
To strengthen current and future Christian and other transformational leaders who
are rooted in the timeless truths of Scripture, understand context and culture, and
proactively lead in the midst of today’s global realities.
1.2.2. Perspective and Values Education
SSU provides a worldwide model of graduate education that invites students to
evaluate and reinvent how they accomplish their work. This model includes
education that results in changed values and paradigms, not just added
knowledge. This is accomplished through “come and see” experiences that move
students outside of comfort zones into new global realities. SSU is committed to
not uprooting students from their current ministry/work locations. SSU is facilitated
by global faculty, global communication tools, and student cohorts diverse in
gender, experiences and cultures.
1.2.3. Accessibility to Life-Long Learning
SSU creates pathways for learning that offer front-line practitioners the hope of lifelong, credentialed, high-quality education. Students will be given tools to help them
learn life-long habits of reflection and theological inquiry in the midst of their
leadership action. SSU will be seen not as a three- to four-year relationship, but a
life-long equipping partner, advancing them through degrees and serving them with
on-going teaching, networking and platforming opportunities.
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1.2.4. Virtual Services
SSU utilizes technology, travel and network relationships to provide a high-level of
service to students in various world locations. SSU is not just ‘high-tech,’ but also
‘high-touch,’ emphasizing relationships and the use of technology to create
community, not just dispense information more efficiently.

1.3. Institutional Outcomes
The following represent the value that SSU’s staff and faculty place on their working
relationships with each other, the Boards, and with student
1.3.1. Skills
What hands-on skills will be taught, demonstrated and evaluated throughout SSU’s
academic and non-academic services to students?
•

Students learn how to develop and disseminate experiential
approaches focusing on locally-scaled, global best practices
with appropriate quality and innovation;

•

Students demonstrate transformational leadership-related skills
which can be duplicated, and which create or contribute to redemptive
changes in student’s current life and work;

•

Students are exposed to a learning environment that also teaches
best networking practices which range from the graduate to postgraduate studies and beyond.

1.3.2. Application
How will SSU students apply their learning in their life and work during their
studies and after they graduate, while expanding their own partnerships and
networks and becoming more and more Christ-like?
•

Students are/become influential Christ-like transformational leaders in
their own expanding networks;

•

Students demonstrate an increased missional perspective;

•

Students serve as transformational leaders within city contexts;

•

Students integrate culturally, ethnically, geographically,
gender, and denominationally diverse perspective in their
thought and work.
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2. Class Format

The Sierra States University (SSU) Online Programs generally consists of
professor instruction, reading assignments, online interaction, quiz, book report
and midterm and final exam. The programs are asynchronous learning and
generally offer a quarter based 4 credit hour modules.

2.1. Participation

Your participation in class is critical if you hope to achieve an outstanding grade and
successfully complete your degree. In the online setting, ALL students need to participate
every single week from the very first week. It is not fair to the rest of your class to try to catch
up with posts in prior weeks when they have already moved on to the next week. If you fail
to participate in week one, the eLearning Team will alert the Registrar’s Office of nonparticipation. An email will be sent out in Week Two to students who haven’t participated,
advising them that if they do not participate by Week Three, they will be withdrawn from the
class and there will be financial penalties.

2.2. Onsite Classes

When you register for an onsite class on the SSU Populi website, be sure you check the
“Course Information Sheet,” which is updated on a regular basis. It is very important that you
check this sheet before calling the SSU office for general information.

3. Plagiarism
Plagiarism is passing off another’s ideas or writings as one’s own. Plagiarism is
failure to acknowledge material which is copied from others or failure to
acknowledge one’s indebtedness to another for even the gist of important
thoughts in a formal statement, written or oral. If you quote anything you must
footnote the book or other resource from which you obtained the quote or idea.
If you do not do this, it is plagiarism and grounds for expulsion. If a paper is
suspect, your professor will be alerting SSU’s Academic Dean.
Often students are unaware that they have plagiarized. For example, they are browsing the
internet and find an article with which they agree wholeheartedly. They block and paste
large portions of the article but forget that they must give credit to the author(s). Let’s look
at some examples.
Student A was writing a literature review of Larry Peabody’s book, Job-Shadowing Daniel,
and wrote:
The Sunday-Monday gap can make it seem as if everyday work has little or no spiritual
significance. As a result, countless working Christians lead "split-level" lives, unable to do their
daily work wholeheartedly. Any work for God, they suspect, must be done in off-hours or on the
weekends. But as this book shows, Daniel's job in the work world says otherwise- making him
an ideal candidate for job-shadowing, for mentoring contemporary working Christians.

Although the student had changed one or two words, this was a direct quote from a book
report of Peabody’s book without quotation marks and without a footnoted reference. If the
student wanted to avoid plagiarizing, he/she should have written this (note that the quoted
material appears in a block quote, thus no quotation marks are around the quote; however,
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if less than 5 lines had been quoted, quotation marks should have appeared around all
quoted material):
An excellent review of the book Job-Shadowing Daniel by Larry Peabody explained the thesis of
the book by saying,
The Sunday-Monday gap can make it seem as if everyday work has little or no spiritual
significance. As a result, countless working Christians lead "split-level" lives, unable to do
their daily work wholeheartedly. Any work for God, they suspect, must be done in offhours or on the weekends. But as this book shows, Daniel's job in the work world says
otherwise-making him an ideal candidate for job-shadowing, for mentoring contemporary
working Christians 1

Notice that at the end of the blocked quote, there is a footnote which would reference the
website where the book report appeared. Quotation marks should always appear around all
words that have been taken from another source (except in a block quote — a quote of over
4 lines — where quotation marks are not necessary).
If you want to quote parts of an article or book while inserting your own words you can do
so like this:
An excellent review of the book Job-Shadowing Daniel by Larry Peabody explained the thesis of
the book by explaining that “the Sunday-Monday gap can make it seem as if everyday work has
little or no spiritual significance.”1 Peabody’s book helps the “working Christians [understand how
it is possible not to lead] ‘split-level’ lives, unable to do their daily work wholeheartedly.”2

The words in brackets indicate your own words and not the author’s.
SSU recommends that all of its students use tools to assist them in recognizing quoted
materials and also helping with grammar issues. A great program called Unicheck has been
purchased by SSU for all students and faculty. When this program alerts you to materials
that are quoted from elsewhere and you have not placed quotation marks and a reference,
you will be plagiarizing. So be very careful to check all of your work before submitting to
SSU. Your professors also have access to this program and any suspect materials will be
run through Unicheck to check for plagiarism.
The review of plagiarized work will be addressed in the following manner:
1.

If a professor identifies plagiarism in a student’s work, the student will be allowed to
explain the circumstances. The professor will consult with the Program Director and
may allow the student to re-write the project to eliminate all incidents of plagiarism if
this is the student’s first offense.

2.

If the student has plagiarized in other courses, the Program Director may impose a
failing grade for the current course and the student may incur other penalties, up to
expulsion from the school.

3.

If a student’s prior work is found to contain plagiarism, the grade for the course or
work is subject to change.

4.

If a degree has already been granted at the time the violation is discovered, the
degree may be revoked.

In each occasion listed above, when possible, students will be given coaching and the
opportunity to address their plagiarism and penalties will be determined by the Academic
Dean taking into consideration the severity of the plagiarism and the degree of the student’s
repentance, diligence, and timely response.
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4. Grading
In general, each course consists of several elements. Each element is assigned a different
amount of points therefore It is very important that you follow the instructions contained in the
syllabus. The elements are:

4.1. Quiz

During the course, student will take quizzes to present their obtained knowledge. Every session
will include quiz except session that include midterm and final exam.

4.2. Discussions

Students share their point of views and their own experiences throughout the discussion board.
Each student must write at least of 1 posting no later than every Wednesday, and engage
discussions with other students by replying 2 other’s postings.

4.3. Book reports

Students will be assigned book report throughout the course to obtain knowledge in depth.
Each report will be including, but not limited to, case study, article analysis, research.

4.4. Midterm and Final Exam

At the middle of the course and end of the course, students will take the midterm and final
exam to present their obtained knowledge throughout the course. See “Appendix A: Grading
Rubric” for grading details. All professors use this rubric, so if you have received a grade that
is below what you believe you should have received, please ask your professor to identify
where on this rubric your project appears.
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5. Academic Writing
5.1. Organizing Skills
Here are some tips for all students that have been gathered over the years that could prove
especially helpful. These include:
5.1.1. EndNote Program
SSU recommends to use the EndNote for your writing assignment. Start using
EndNote from your very first course. You can insert the bibliographical data for each
book just once and it will organize your references for the future work you do. Be
sure to indicate that you want to use the APA format.
5.1.2. Mark it Up
When you are reading a book, highlight items that you want to remember, coding
them according to their importance. For example, some people use a small underline
for relatively important quotes, two underlines for more important quotes, and a star
in the margin for something very important. Some people fold the pages down in
varying degrees (the larger the fold, the more important the quote on that page).
Some use post-it notes on pages with a key word written on the post-it for quick
reference.
5.1.3. Record Quotes
Once you have finished the book, record the very important quotes in some manner.
Some people like to keep a file on their computer that saves references by topic.
Others prefer to keep note cards for each quote and file them by topic. Some write
the quotes on a small yellow pad. At the top of the first page, write the bibliographic
information and beside each quote (be sure to include the page number) write a key
word in the margin. Staple the pages for each book and then alphabetize them by
title or author of the book. This last suggestion is helpful because you don’t have to
write down the bibliography on each note card. Whichever way you decide to keep
your quotes, at least do something.
5.1.4. Book reports
Always write your book reports immediately after having read each book and before
starting your next book. It is too easy to forget what you read if you start reading the
next book
5.1.5. Books
Keep your books alphabetized by subject matter, grouping subjects together with a
larger post-it to indicate the subject on the first book in each section.
5.1.6. Backing up
Always back up your work and backup again on your computer, cloud service,
external storage. There have been so many cases our students lost their entire
project just as they were finishing because they didn’t make a backup. You can also
email it to yourself and save the email.
5.1.7. Folder for each class
Saving your work in separate folders on your computer for each class makes it a
whole lot easier to find specific documents later.
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5.2. Academic Level Writing
As you enter into your online program at SSU, the automatic assumption is that you have
come with some academic knowledge. However, very often we find that the end product is
inconsistent with the content. By that we mean that the brilliant thoughts that you have
tried to convey in your work become lost in the typographical or formatting errors in which
the work is presented. This handbook is designed to assist you to at least identify some of
the more common errors. If you feel that you need more help to produce work that is at
graduate level, we recommend that you take SSU’s academic writing certificate. Also, see
page 7 of this handbook for information about the Unicheck program that SSU has
purchased for you.
Academic writing is not the same as writing on your blog, but it does follow the same basic
rules for sentence structure, punctuation, spelling and capitalization. However, the language
is definitely more formal, and there are some punctuation, capitalization, and formatting
peculiarities. Completed course projects must be presented in APA format and
include all of the following components: 1) title page; 2) contents; 3) book reviews; 4)
journal; 5) assignment(s) if required; 6) project; 7) self-evaluation; and 8) references. All
of these elements are provided in the Paper Template and this Student Handbook, both of
which you may download from the Populi classrooms. If the project is not in the proper
format, it will be returned to you with instructions to format correctly.
The SSU’s Online library in Populi also has APA guides and tutorials, which can be found in
Populi under the “Library” tab. General writing assistance is available free of charge, as well
as optional customized services at nominal rates. You might ask yourself why it is so
important to write every paper in proper formatting. The most important reason is that at the
end of your program you will be required to write a thesis, dissertation or capstone which,
by the standards of every higher education institution, must be in an academic format. By
requiring you to write all of your papers in this format from the very start, you are learning
years ahead of time how to write and format properly. We hope that when it comes time for
you to write your dissertation/ thesis, formatting will not be (as big of) an issue.
Your biggest question now is probably, “How do I get an ‘A’ paper?” The surest way to do
so is to follow directions. Read your syllabus carefully and keep in mind the four elements
that every paper should include: 1) your observations; 2) an analysis; and 3) personal
reflection (see “Grading” below). Another thing you should always remember to do before
turning in a paper: do a spell and grammar check and have your paper checked for
plagiarism by Unicheck.

5.3. Common Writing Mistakes
5.3.1. Punctuation
Quotation Marks: Virtually all punctuation should appear within the quotation marks,
including periods and commas.
● Yes, even if the period or comma is not a part of the original quote.
● Colons and semi-colons always go outside of quotations,
Examples :
The grass was always considered “green”:
● Question marks and exclamation points go outside of the quotes unless
they are part of the quotation itself,
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Examples :
“Don’t you want any part of our mess”?
“I’d be more than happy to join you!”
Numbers: Numbers from one to ten are spelled out in APA and the remainder
numerically. There are, as always, exceptions. Here are some of those peculiarities
we mentioned:
● When writing a date, spell out the month and do not use ordinals (e.g. 4th) for
example, July 4, 1776 not July 4th, 1776. Use numbers for a single year, e.g.,
1968. When talking about a decade, do not use an apostrophe between the
year and the “s” as in “the 1960s.”
● When citing percentages, type“19%.” for APA format
● Spell out round numbers (hundreds, thousands, hundred
thousands, millions), e.g., one thousand.
● Spell out numbers that begin a sentence: “Ten thousand people visited the
church.”
● Use numerals when expressing numbers of a million or more: “There are
nearly 7 billion people on the planet.”
Series Comma: When using a series comma, use a comma after the first item, the
second item, additional items, and a comma before the conjunction (and, but, et al.).
5.3.2. Quotations/Citations
Accuracy: If you are going to use quotations they must always be accurate and
should be quoted word-for-word. Do not correct the writer’s grammar, spelling, etc.
If they write “17% of the Earth’s population,” (capitalizing the “E” in earth when it
should not be) then quote it verbatim.
Errors: If the author has misspelled a word, write sic in brackets and italicized.
For example: “The ship had veered [sic] off course by five miles.”
Inserting words: Any time you add a word to assist in the explanation of what you are
quoting or to replace the word “it” or “that” so the meaning becomes clear, put that
word or words in brackets. For example: “The Captain wanted the crew to understand
[the rules].” Although if the explanatory words are at the end of the sentence, the
same quote could be written: “The Captain wanted the crew to understand” the rules.
Referencing Quotes: Whenever you quote anything, you must use quotation marks
and mark the citation in parenthetical reference (APA). For APA, quotes of more than
40 words must be set off as a block quote, indented .5”, and double-spaced. Do not
use quotation marks in a block quote unless they are used in the quoted material
itself. Any quote within a quote should be set off with a single quotation mark. For
example, “Mary said, ‘Yes,’ but was still afraid of the consequences.”
Book reports: We previously allowed students to simply cite page numbers in
parentheses within the book reports. However, we have realized that when you are
using the EndNote program it makes more sense to quote properly using a footnote
so every book appears in your Bibliography or References (APA) without your having
to manually add the books.
In academic writing, any comment that you make that is common knowledge does
not require a footnote and reference. For example, “The first President of the United
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States was George Washington.” Everyone knows that and it doesn’t require a
source. A good example of a reference that does require a footnote and source would
be a statement like this: “Over half of the world’s population now resides in urban
centers. There are an estimated five hundred cities in the world with one million
people or more.” This information is not common knowledge, so the source of the
information would need to be provided.
Bibliography: Bibliographies and References (APA) exist so that the reader can find
the information about a reference work without having to search through your paper
to find the notation with all the information. The works referenced in bibliographies
are alphabetized by author. A Works Cited section is not needed in addition to the
bibliography; the bibliography is sufficient.
5.3.2. i.e. or e.g.?
i.e. comes from Latin id est. It is equivalent in meaning to 'that is.' It is used to
introduce a rephrasing of a previous point, a definition or a further clarification or
explanation of a preceding point. Example: “The ability to learn language is innate
(i.e. part of our inborn genetic makeup).” The phrase after 'i.e.' defines 'innate.' Notice
that it would be fine to write 'that is' in place of 'i.e.'
e.g. comes from Latin exempli gratia. It is used to introduce an example of a
previously- mentioned phenomenon. It is the equivalent of the English phrase 'for
example.' Example: “Humans have several innate abilities (e.g., language learning,
walking, and recognizing faces).” The material after 'e.g.' does not define or explain
'innate abilities'; it merely lists several particular examples of such abilities. Notice
that 'for example' is an appropriate substitute for 'e.g.,' but 'that is' is not.

6. Research
Research is the work you will do to answer a question you either do not already have an
answer for or cannot prove the answer you think you have. You will conduct research during
your writing of the Book Report and Discussion Thread, There are two primary kinds of
research. One involves using experimentation, gathering information quantitatively or
qualitatively, postulating a hypothesis, testing a theory, and/or making conclusions based on
the results of your research. Research utilizes consulting books, periodicals, lectures, etc. to
support a thesis. You will use this method for your papers and final dissertation.

6.1. How to find it after I’ve read it?

SSU students are very creative when it comes to finding something they read in one of the
books for a course weeks after the class and it is time to write their project. Here are just a
few examples that students have shared with me. What is important is that you find a method
that works best for you:
● Mark your text, either by underlining, highlighting, making notes in the margins, postit notes on pages with a few brief words to help you recall, or the “dog-ear” method
(folding down the corners of pages, folding a bigger portion on pages where more
important information can be found).
● Either immediately or shortly after reading the book, jot down the quotes that you
know you will want to return to at a later time. Some people use 3 x 5 index cards,
some simply stick with the post-it notes, some keep quotes in their computers, and
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some have a blank book or a notepad in which all of the quotes are listed

6.2. Library Research

We live in an age of technology, so much of your library research can actually be done from
the comfort of your own computer. However, there is something to be said for walking to a
section of the stacks of books and simply perusing the shelves. There are, however, many
online resources that you can research.
●

●
●
●
●

SSU offers an Online Library through which SSU students worldwide may access a
rich collection of research guides and resources. These resources are available for
both business and theology students, wherever they may be located, including
access to thousands of e-books. The Online Library is overseen by a full-time MLS
Librarian, who is available to assist students with in-depth research, search
strategies, referral, and reference questions. The Online Library also provides
guidance on academic writing, citation styles, and guidelines, and provides a portal
for students to express feedback and contribute suggestions on additional resources
for the Online Library. To access the Online Library, log into Populi and click the word
“Library” in small white letters in the black strip just under the URL. Most of the
following items can be found under the tab called “links.” Check the Orientation
Packet for an instructional video from SSU’s librarian.
Local Library Options: To find a variety of public, college, university, private, and
school libraries in your area that are open to the public, visit : http://nces.ed.gov.
Many libraries participate in the interlibrary loan program if the book you are seeking
is not in your local library. You can find which library has the book you want by
accessing: http://www.worldcatlibraries.org.
Periodicals (newspapers, magazines, journals, etc.) are indexed in a variety of
databases, depending on the library. SSU’s online library contains a plethora of
resources for your use.
ProQuest™ - SSU has also purchased ProQuest, a program that allows you to
access literally thousands of journal articles and, in some cases, full texts of articles
and books. This resource is also accessed through our online library.

6.3. Online Research

There are literally billions of web pages, at least 200 billion of which are not indexed. Experts
believe that search engines actually index less than 10 percent of the entire Internet (Google
only indexes 4 percent and it’s the largest search engine to date!). Most of the Internet is
stored in what are called databases and dynamic-websites. The 90 percent of the un-indexed
Internet is called the Invisible Web. Also try going to Google Scholar
(https://scholar.google.com/) and enter your topic to see other sources that may be helpful.
● Visible Internet: There are two main types of search engines for the visible web,
search engines and subject directories.
● Invisible Internet: Start by searching on the visible Internet for the kind of database
you need, and then search databases. Use directories that index databases.
6.3.1. Online Research Resources
Search Engines
http://www.google.com
http://www.yahoo.com
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Relevant Invisible Web Databases & Directories
http://www.infomine.ucr.edu (collection of scholarly links reflecting
selected university-level subjects and disciplines)
http://www.findarticles.com (free and for fee academic and consumer
articles)
https://www.highwirepress.com//(largest repository of full-text, peerreviewed articles)
http://www.libraryspot.com (collection of databases, online libraries,
references)
http://www.firstgov.gov (all sorts of government databases)
http://www.academicinfo.net (directory of academic databases)
http://www.odci.gov/cia/publications/factbook/index.html (searchable directory
of flags of the world, reference maps, country profiles, etc
Other useful Research Sites
http://www.thearda.com (American Religion Data Archive-quantitative data
from nationwide surveys)
http://www.worldchristiandatabase.org/wed (World Christian Databasestatistical information on world religions, Christian denominations, and people
groups)
http://www.pollingreport.com (Repository of polls from multiple sources)
http://www.adherents.com (repository of worldwide religious affiliation
statistical data)
http://www.gc.cuny.edu/faculty/research_briefs/aris/aris_index.ht
m
(American Religious Identification Survey)
http://hirr.hartsem.edu/sociology/sociology_research_resources.
html
(Harford Religious Research Resources-directory of numerous databases)
http://www.ellisonresearch.com/PastorStudy.htm (Ellison Research:
Protestant Clergy and Laity Research)
http://www.valpo.edu/geomet/geo/courses/geo200/religion.html (map
gallery of religion in the US from Glenmary Research Center)
www.athensams.net/myathens (great research database)
http://www.ralphdwinterlibrary.org/aboutrdwl/newnevents23.htm (an online
library)
www.globethics.net (Social sciences and theology libraries online – free)

7. Assignments
7.1. Quiz
Every course you take at SSU will require a quiz per session to present your obtained
knowledge. Every session will include quiz except session that include midterm and final
exam.

7.2. Book report

The book reports should be written in the more “formal” academic language (not casual
language) and should not be a restatement of the book. It is important that you always read
your syllabus carefully because, although the course requirements are similar for most
Page 15

courses, professors will occasionally change those requirements, including the requirements
for book reports. Make sure you are following your directions. Be sure you have referred to
or quoted from all of the books in the project portion of your paper.
Every book report should contain three elements:
First paragraph: State the author’s intent for writing the book, which includes the main thesis
(100 words max).
Middle paragraph: Interact with the author’s message. For example: Did you agree or disagree
with a specific idea? Why? How does the message of the book fit in with issues you had been
struggling to understand before reading it? What points did the author make that were
completely new to you—and why are they significant to what you do? What ideas left you
wanting to explore them further, and what were your unanswered questions (300 words max.)
Final paragraph: Explain how something you read in the book will change the way you do your
own work. Be specific providing concrete action steps. Phrases such as, “I will...” or “I plan
to...” are appropriate here. Avoid vague generalizations (100 words max).

7.3. Discussion

Students share their point of views and their own experiences throughout the discussion board.
This will opportunities to share each student’s point of view regarding the weekly topic and
exchange their opinions. Each student must write at least of 1 posting no later than every
Wednesday, and engage discussions with other students by replying 2 other’s postings. One of
the most important aspects of an online course is the interaction between students. This
discussion provides a great opportunity for students to get to know each other. Please make
certain that your post is well-written, grammatically correct, and informative.

8. Assignment Formats
8.1. Bibliography/Reference

This section should be no problem to do if you have added all of your reading using
a reference management programs such as EndNote, Refworks. The reference
page will include all of your readings as well as any books or articles you might
have referenced (footnoted). Remove all of the books that are listed as samples in
the template and insert your own list. Be sure to note how you are to handle two
books by the same author and other distinguishing changes between the book
reference in the footnote as opposed to the bibliography.

8.2. Table of Contents
After you have completely finished writing your paper, you will need to re-generate the table
of contents and re-format according to the APA requirements. The APA table of contents is
one of SSU’s “special” formats and follow these formatting instructions. Here are the steps
you will take for Word 2003:
Put your cursor in the Table of Contents that currently exists there.
a.
Go to “Insert” in your tool bar
b.
Click on “reference”
c.
Click on “Indexes and Tables”
d.
Click on the tab that says “Table of Contents”
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e.
f.

Click on “Show Outlining Toolbar”
Click “Okay”

This should generate a new updated Table of Contents but you have lost all of your
formatting and the number in front of each Chapter heading. Your next steps are:
a.
Block the entire Table of Contents
b.
With the table blocked, click the B (bold) twice so everything is un- bolded;
click the I (italicize) twice so everything is un-italicized; and the U
(underline) to un-underline everything.
c.
With the table still blocked, click on Format
d.
Click on Tabs
e.
In the blank type “.5”
f.
Click the dot in front of “left”
g.
Click on “Set”
h.
Now right before the word “book reports” type a number 1 and hit tab
i.
In front of each of your book titles insert a tab to line them up with the title
of your chapter
j.
Do the same for each of your chapters and subheadings
k.
If you have second or third level subheadings, you will need to add another
tab position for each, i.e. set one at 1.0” and 1.5” for two more levels of
subheadings if you have them.
If you want to know how to format the table of contents from scratch (oh, you brave
souls), position your cursor where you want the Table of Contents to appear
and from the tool bar:
a.
Click on “Insert”
b.
Then Click on “reference”
c.
Click on “Indexes and Tables”
d.
Click on the tab that says “Table of Contents”
e.
On the bottom left where it says “Format” click the down arrow and choose
“Classic”
f.
Make sure there are 3 levels
g.
Show page numbers
h.
Dot leader
i.
Right align page numbers
j.
Click on “Show Outlining Toolbar”
k.
Click “Okay”
Now that you have clicked on “Show Outlining Toolbar” you will see at the top of your
screen one of the boxes that probably says “Body text.” If you want to add a title to
your table:
a.
Place the cursor on that line and hit the drop-down box next to Body text
b.
Choose the level you want the text to appear in and click on it
c.
Now if you regenerate your table you will see that line added to your list of
items. Unfortunately, in the new 2007 version of Microsoft Word that box does
not appear. However, if you go to the “Reference” tab you will see a place to
change the level of your items OR (and this is important if say a whole
paragraph appears in your table of contents that should not be there) change
the paragraph or item you don’t want in the table to “Body text” or
“Paragraph.”
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To create a table of contents in Word 2007, follow these instructions:
a. Click on the “References” tab at the top.
● If a table of contents already exists (as in the Paper Template) simply
click on “Update Table”
● If a table does not exist click on “Table of Contents” and at the bottom
click “insert table of contents” then be sure you click on “modify” and
then click on each level individually to change the formatting.
b. TOC level 1 should be:
● Double-spaced
● Left align 0
● Right align 4 (this brings in the title so a long heading won’t interfere
with the page numbers)
● Set tab at 6.00” right aligned and dot leader
c. TOC level 2 should be:
● Double-spaced
● Left align 3
● Right align 4
● Set tab at 6.00” right aligned and dot leader
d. TOC level 3 should be:
● Double-spaced
● 12-pt after
● Left align 6
● Right align 4
● Set tab at 6.00” right aligned and dot leader
To create a table of contents in Word 365, follow these instructions:
a. Put your cursor in the Table of Contents that currently exists there.
● Go to “References” in your tool bar
● Click on “Table of Contents”
● Select one of built-in table
● Click “Okay”

8.3. Indexes

For Indexes, go to the last page of your paper and type “Index” at the top of the page, hit two
hard returns, then follow these instructions for Word 2003:
a. Click on “Insert”
b. Then Click on “reference”
c. Click on “Indexes and Tables”
d. Click on the tab that says “Index”
e. Click in the box that says “right align page numbers”
f. Click Okay
You are probably getting the message “Error! No index entries found.” This is probably
because you have not marked any words. Go to a word or phrase that you want to appear
in your index and highlight it.
a.
b.

Click on “Insert”
Then Click on “reference”
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Click on “Indexes and Tables”
Click on the tab that says “Index”
Click on “Mark entry”
Indicate the main entry (sometimes people put “A” “B” etc. and in the second level they
put the word)
g. You don’t have to put anything in the secondary entry if you are using the word as the
main entry
h. Click Okay and then go back and re-generate the index and your word or phrase
should appear.
c.
d.
e.
f.

For Word 2007 follow these instructions:
Go to the “References” tab
Click on the words “Insert Index”
You may modify the formatting of your index in this area
Click “okay”
Now go into your document and find a word you want to index
Go back into the “References” tab and click on the word “Mark Entry”
You may have one or two levels of your entries (as noted above, some people use
the first entry for letters of the alphabet under which corresponding words appear but
you would only use this option if you had a very large index)
h. Go back down to your index and click “Update Index” under the “References”
tab
a.
b.
c.
d.
e.
f.
g.

For Word 365 follow these instructions:
a. Select the text you want to reference. The text can be a word or a phrase or any old bit
of text.
b. On the References tab in the Index group, click the Mark Entry button. The selected
text appears in the Mark Entry dialog box.
c. If the entry needs a subentry, type that text in the Mark Index Entry dialog box. The
subentry further clarifies the main entry. For example, the word you select (the main
entry) might be boredom and you type In a waiting room as the subentry.
d. Click one of the buttons, either Mark or Mark All. Click the Mark button to mark only the
selected text. Click the Mark All button to direct Word to include all matching instances
of the text in your document. When you mark an index entry, Word activates the
Show/Hide command, where characters such as spaces, paragraph marks, and tabs
appear in your document. Don’t let it freak you out. Because Show/Hide is on, the Index
code appears in the document.
e. Continue scrolling your document and looking for items to place in the index. The Mark
Index Entry dialog box remains open as you continue to build the index.
f. Click the Close button when you’re done, or just tired, to banish the Mark Index Entry
dialog box.
g. Press Ctrl+Shift+8 to cancel the Show/Hide command. Use the 8 key on the keyboard,
not on the numeric keypad.
Always save your papers using your last name first, the course number, and course name
(shortened or abbreviated is fine). For example, if Joe Smith took the Overture II in China,
he could save the document as “Smith OV2 China.doc.” If Sally Green took History, she
would save the document as “Green HST601 History.doc.”
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8.4 Tables & Figures
Although primarily used by those who are writing a dissertation or thesis, knowing how to
format and index your tables and figures gives your document a more professional look. If
you have tables or figures, create an “Illustrations” page immediately following your table of
contents.
A. To set up the page
○ Entitle the page “ILLUSTRATIONS” and mark as heading 1 (if you just
have figures or just have tables, entitle the page either “FIGURES” or
“TABLES” with no sub-heading).
○ To the far left type the word “Figures” and/or “Tables”
○ Position your cursor two spaces below
○ Go to the References tab and click on “Insert Table of Figures”
○ Now click on “Modify” and change the formatting to:
■ Single-spaced
■ 12 pts after
■ Hanging indent .25”
■ Left margin .25”
■ Tab to 6.00”, right aligned with dot leader
B. To mark a table or figure:
○ Insert the table or figure in your document
○ For a table place your cursor above and for a figure it goes below
○ Click on the References tab
○ Click on “Insert Caption”
○ Where it says “Label” choose whether this is a table or figure
○ After the word “Figure” and the number (or “Table” and the number)
insert a period, space and the title of the table or figure, capitalizing only
the first word of the title (unless it’s a proper name)
○ Click “Okay”
○ Go into your styles menu (see instructions below) and change the
formatting for “caption” to:
■ Single-spaced
■ 10 pts
■ Bold
■ 10 pts after
Formatting Issues
Citation of sources
Content footnotes
Use of block quotes
Line spacing of block quotes
List items

APA
Parenthetical only
Acceptable
Over 40 words
Double-spaced, indented
Double space all items

Listing of sources
Spacing in source lists

Reference List
Double space all entries

Capitalization in source lists

Capitalize only first letter in titles of books,
dissertations, reports, as well as articles from
journals, newspapers, and the internet; capitalize all
proper nouns; use title case for journal and
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newspaper titles)
Tables

Table title is double-spaced, appears above the
table; with “Table #” in non-italic, 10-pt. font and title
text is italicized, not bold and on 2nd line.
See examples below.

Figures

8.5. Using the Styles Menu
In order to really format your paper properly, you need to know how to use the
Styles Menu in Word. This is a very helpful tool that will streamline your writing if
you can learn to use it well.
A. Let’s start with a first-level heading
Place your cursor on the title that you want to appear as heading 1
Click on the “Home” tab
To the right of your toolbar above the word “Styles” you should see several
white boxes with various styles in them. In between those boxes and the far
right where the words “Change Styles” appears, click on the very bottom down
arrow.
o Now click on “apply styles”
o This should open a box to the left of your screen
o With your cursor still on the title you want as heading 1 type “Heading 1” into
the box under “Style Name”
o Now you need to click on “Modify” to be sure that heading 1 is formatted
correctly:
▪
First check to be sure that the font is Times New Roman and font
size is 12 pt
▪
Make sure it is bold
▪
Make sure it is centered
▪
Now click on “Format” and then “paragraph” and change to doublespaced, 18pt before and 18pt after
o
o
o

B. Now let’s format a second-level heading
Place your cursor on the title that you want to appear as heading 2
Click on the “Home” tab
With your cursor still on the title you want as heading 2 type “Heading 2” into
the box under “Style Name”
o Now you click on “Modify” to be sure that heading 2 is formatted correctly:
▪
First check to be sure that the font is Times New Roman and font
size is 12 pt
▪
Make sure it is bold
▪
Make sure it is centered
▪
Now click on “Format” and then “paragraph” and change to singlespaced, 18pt before and 18pt after and say “okay”
o
o
o

For level 3 headings use the same procedure but the format is left aligned, single-spaced
with 12pts after, bold and italicized. You can use this procedure with all of the different styles.
A warning, however. If you change the “Normal” style to the way that all paragraphs in the
APA format should appear (double-spaced, left justify only, indented .5” for the first line, and
no spaces before or after) it changes everything in your paper. Instead, I usually create a
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style called “paragraph” that is formatted correctly.

8.6. Formatting Lists

Using the Styles Menu you can also format your lists (style is called “List Paragraph”). Here
is an example of a list in APA:
●
●
●
●
●

Times New Roman
12 pt font
Double-spaced
Hanging indent at .25”
Left margin at .25”

8.7. Footnotes and Bibliographies
8.7.1. APA Documentation Samples
The following samples show APA formatting for parenthetical referencing and
reference lists. For instance if you are using the article “Business executives'
perceptions of ethical leadership and its development” written in 2013 Catherine
Marsh, the reference formats are;
In the Text
“ ...providing the actual perceptions of the business leaders as to what life
experiences of theirs have formed the development of values and characters
(Marsh, 2013)”
In the Reference List
Marsh, C. (2013). Business executives’ perceptions of ethical leadership and its
development. Journal of Business Ethics, 114(3), 565-582.
8.7.2. Electronic Sources Article (e.g., Web Articles)
In the Text
(George Fox University, 2008, para. 2)
In Reference List
George Fox University. (2008). Spiritual formation. Retrieved October 28,
2008 from http://www.georgefox.edu/seminary/about/formation.htm.
(If the website is not subject to many changes, the retrieval date is optional.)
8.7.3. No Person or Organization Shown as Author for Internet Articles
In Text
(“Antipsychotics,” 2008)
In Reference List
Antipsychotics dangerous for elderly with Dementia. (2008). Retrieved from
http://www.nlm.nih.gov/medlineplus/news/fullstory_65042.html
(If the web article appears to be written by staff of a governmental agency or
other organizations, name of the agency or organization may be used in the
author location if no other author is indicated. The main issue is to make
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sure the parenthetical reference in the text begins in the same manner as
the entry in the Reference List.)
8.7.4. One Source Quoted in Another
In the Text
Brueggemann (as cited in Griffin, 2007, p. 64) discusses...
In the Reference List
Griffin, Winn (2007). God's epic adventure: Changing our culture by the
story we live and tell. Woodinville, WA: Harmon Press, 2007
8.7.5. Thesis or Dissertation
In the Text
(Melton, 2006)
In the Reference List
Melton, Judi (2006). Philosophy of ministry. Sierra States University, Seattle,
WA.
8.7.6. Lecture from a Symposium Type Class such as an Overture
In the Text
(Barnes, 2005)
In the Reference List
Barnes, Grace (2005, May). Introduction to transformational leadership.
Lecture in Overture I course at Sierra States University, Seattle, WA.
8.7.7. Kindle Type Reference
In the Text
(Trible, 1978, loc. 288-90)
In the Reference List
Trible, Phyllis. (1978). God and the rhetoric of sexuality [Kindle edition].
Philadelphia: Fortress Press.
SSU Modifications to APA Format
No running heads
Roman numerals in front matter, then begin
chapter one with Arabic numeral 1
Option 1: Page numbers bottom center of all
pages
Option 2: Bottom center of first pages of
chapters with remaining chapter pages at
top right

APA Format (6th Edition)
Running heads throughout document
All Arabic page numbers beginning with title
page
Page numbers at top left for all pages

8.8. Tools

EndNote program is exceptionally helpful for you in writing your papers because
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it will automatically update your References or Bibliography every time you add a
new resource. In addition to that, you can obtain the complete information about
a book by searching in the Library of Congress, which means you don’t have to
type in all of the information. It appears automatically.
8.8.1. EndNote APA setup
Open the EndNote program and under Edit, Output Style, Click on Open Style
Manager. This will bring up a list of styles. Choose the option to unmark ALL and then
scroll down until you find APA. Only this box should be checked. When you open Word
under endnote Style, you must select APA as the format.
To install the program using the email link follow these steps:
1. When you first go to the link to EndNote, click on the link and choose the type of
computer you have. (Be sure ALL programs, especially Word and Excel are
closed.)
Select to download and then SAVE it to your desktop (this is the easiest way to
find it later).
3. Once the document has been saved, right click on the EndNote icon on your
desktop and click on “extract” (NOT open or run).
4. This will extract the program and save it under your programs file on your
computer.
5. If you have received the message that you need a password or number, you
have done it wrong. Start over.
6. Open a Word document and the EndNote tab should appear on your toolbar. Click
on
the tab and where it says “Style:” change the dropdown box to say “APA.”
7. Now click on “EN Go to EndNote.” Now you need to create a new library. Click on
“File” on the toolbar and then “New…” to create a new library. Type in whatever
name you want.
8. Now you need to tell EndNote to format everything according to APA formatting
rules. Go to “Edit” then “Output Styles” then “Open Style Manager.” Click the
button that says “unmark all” and then click only “APA.” Then close Style Manager
by clicking on “File” and then “Close Style Manager.”
9. Now you’re ready to add your first book.
2.

In APA style, it is sometimes not very practical to try inserting the reference within the
text using the EndNote program. However, here’s a trick I have learned that works very
well to create your Reference page:
Add your books to the EndNote program
Once all of your books and articles have been added, highlight (click and hold
down the control key to go through the entire list to highlight the ones you
want)
3. Right click and choose “Copy Formatted”
4. Go to your References page and click Control+V
5. Block the entire list that has just appeared
6. Then format to be double-spaced, Times New Roman 12 pt.
8.8.2. To use EndNote:
1. First create a new library where all of your references will be saved.
2. Click on “Library of Congress” under Online Search, which will search for
your resource. (This will only work if you’re hooked up to the Internet.)
1.
2.
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For example, type in “SSU” in the author field and then “theology as big” in the
title field and then click on “Search.” You will see the search say something like
1 of 1 found. If you don’t get ANY sources, try reducing the words in your
search. If you get too many responses, click “cancel” and add more words to
your search to narrow it down.
4. Now if you double click on the book, you can edit some of the data to meet
the APA format standards. Some of these changes include:
a. EndNote puts a space right before any colon in the title, which should
be removed;
b. Make sure that all states are just the two-letter abbreviation. For example,
sometimes the Library of Congress puts in “Oreg.” instead of “OR” so that
will need to be changed. No period, either.
5. For APA, go back into your document and place your cursor at the end of your
quote. Go back to EndNote and click on the reference you’re quoting then click
on the “insert citation” icon (which is the box with just a single quotation mark in
it) located in the top toolbar. The citation will appear automatically in your
document and in your Reference list. To add the page number, place your
cursor on the reference in your document so it is greyed out, right click, click
“edit citation” and then click on “more” and then add the page number in the
space provided then hit enter.
3.

8.9 APA Format
8.9.1. Basic Requirements
The APA style requires that you follow these basic requirements:
Paper:

Your paper should be typed and printed on standard 8.5” x 11” paper.

Set all margins at one inch (top, bottom, and sides) except when
the project is to be bound, in which case the left margin should be
1.5”.
Alignment:
Align text to the left.
Indentation:
Indent the first line of all paragraphs one half inch.
Line Spacing:
Double space the entire ocument
Font Type:
Use the Times New Roman font.
Font Size:
Set at 12 point.
Paper Sections:
Your paper must have four main components – Title
Page, Abstract, Body of the Paper, and a list of
References.
Page Header:
Set a page header beginning on the title page one half
inch down from the top margin and align the text to the left
with the page number set flush right. The title page header
reads ‘Running head: TITLE OF THE PAPER’. All
subsequent pages carry the TITLE OF THE PAPER as the
page header but not the words ‘Running head:’.
Page Numbering: Start with page 1 on the title page and number all the following
pages consecutively. While maintaining the numbering, start the list
of References on a new page and also each Appendix on a new
page.
Citing within the text: Use the author-date citation system, for example (Warner, 2008)
Margins:
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References: All citations must be listed in a list of References. The page(s) of
References follow the main body of text and start on a new page.
See the section below on references for more guidelines.
For a sample of a paper in APA Style formatting, click on the link below: https://owl.purdue.edu/owl/research_and_citation/apa_style/apa_formatting_and_styl
e_guide/general_format.html
For a tutorial on the basics of the APA writing style, please click on the link below: https://owl.purdue.edu/owl/research_and_citation/apa_style/apa_formatting_and_styl
e_guide/in_text_citations_the_basics.html
8.9.2. References in APA Format
It is extremely important that every work or author cited in the text is cited
in a listed on the page(s) of references in the section following the body of
text. Your reference section fully acknowledges the work of the sources cited
in your paper and should contain only references cited in your paper.
Margins:
Set all margins at one inch (top, bottom, and sides).
Heading:
The page heading is ‘References’ and must be centered.
Author Order: Use the alphabetical order (A – Z) by the author’s surname.
Only the author’s surname is spelt out with initials used for first
and middle names (e.g. Swindler, M. L.)
Indentation: Use the hanging indent style, that is, the first line of
each reference is aligned flush with the left margin but the second
line is indented one half inch.
Line Spacing: Double space the entire list of references
Numerals:
Spell out numerals for references beginning with numerals
The web site links below also provide additional APA citation guidelines. Consult the
manual for in-depth and complete details on citations.
APA - FAQ’s - http://www.apastyle.org/learn/faqs/index.aspx
Click on the links below to see examples of formatting of references
https://owl.purdue.edu/owl/research_and_citation/apa_style/apa_formatt
ing_and_style_guide/general_format.html

9. Independent and Directed Studies

You may include a total of two courses (or maximum 8 credits) of Independent or
Directed Study courses in your program. Any exception to this policy must be
approved by the Academic Cabinet. An Independent Study is defined as a course
that you design with the assistance of an advisor. A Directed Study generally includes your
participation in a seminar or conference.
Strict procedures of control and accountability must be in place for the programs to fulfill your
stated purposes and reach your desired outcomes. You must obtain the service of existing
faculty for supervision or propose another qualified course advisor from outside the institution.
All such programs must be approved by the Academic Cabinet in advance.
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Independent or Directed Study courses are generally designed for four (4) credits each
Reading and writing requirements match those of courses in SSU programs. Reading
requirements and project paper requirements have been outlined above and relate specifically
to your degree and the number of credits desired. You may negotiate the number of pages
read and project paper length as long as you have contributed an appropriate balanced
minimum of 45 hours of academic work per credit into the course. If you are taking a Directed
Study that involves a seminar or conference, the actual participation time spent during the
conference may be counted toward the total number of hours allotted to the course.
You can request the Independent or Directed Study Contract and Policy from the Registrar.
You must submit the completed forms along with proposed syllabus, advisor information, and
tuition payment to the Registrar for approval by the Academic Cabinet. Tuition is calculated at
the current rate of tuition per credit. If the study is not approved, the tuition will be refunded.
You must propose an Independent or Directed Study advisor who has a doctoral- level
degree and who will evaluate your work for SSU and assign a grade at the end of the course
study. If a non-SSU advisor is proposed, the advisor will need to be approved by the
Academic Cabinet, which can take place at the time the study is being approved. The
advisor must provide a current vita with the independent study proposal.
If you are interested in obtaining credit from a conference or seminar not offered by SSU, a
request can be presented to the Academic Cabinet and approved on a case-by-case basis.
Supplemental reading and reports may be required depending on your involvement in the
conference or seminar.
The time limit for completion of an Independent or Directed Study is 90 days (3 months)
from the time the course contract is approved. This means all coursework proposed in the
syllabus must be submitted to your advisor at the 90-day due date.

9.1. Independent Studies

When you open up the Independent Study Packet you will find five separate
documents:
a)
b)
c)
d)
e)

The first is an agreement that you sign agreeing to the procedures of an
independent study.
The second is the proposal for an independent study, which needs to be filled
out and agreed upon by you and your advisor.
The third is the contract that needs to be signed by your advisor.
The fourth is a W9 form, which must be signed and filled out by your advisor if
the advisor pays US taxes.
The fifth is a blank syllabus, which you can use as a form to fill in all of the
specific information about your proposed course.

Please read over these documents carefully so you understand the requirements of an
independent study.
If your advisor is one of SSU’s approved faculty, adjunct faculty, or advisors as listed
in the SSU catalog, you do not need to submit a vita for your chosen advisor. If, however,
the advisor is not listed, you must provide a vita of the advisor along with the contract and
the W9 form. The independent study packet in its entirety should be submitted to the
Registrar, who will submit the item for approval. The independent study packet can be found
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in the online library in Populi.

10. Populi
10.1. Logging In

All of your online interaction will take place in a program called Populi (pronounced Pop-ULee). You will receive an invitation from the Registrar’s Office (sent via Populi) inviting you to
create a password therefore you must use a valid email address of yours. The URL to enter
Populi is https://ssu.populiweb.com.This URL will take you to the login screen. It will be
important that you remember your username and password, but if you forget, please email
the Registrar’s Office to have your password reset. Do not save your login information on
public computers(e.g., library, internet cafe)

Once you log in, you are immediately taken to your Dashboard. Any alerts from your
professors, etc. will appear on that screen.
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Click on the words “My Profile” to find your student information. This tab allows you to see
anything on your bulletin board, basic information about yourself, student information,
registering for a class, and your finances.

When you click on the “Info” tab, you will see your basic information. Here is where you
can change your address, email, phone number, and other information about yourself.
This is also where you can change your photo.
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10.2. Getting to the registration page

You can register for courses works when SSU has set up online enrollment periods. Online
enrollment periods start on the date of SSU's choosing and conclude at the course or
term's add/drop date. During these periods, you can enroll in courses, sign up to audit
them, drop courses, and get on the waiting list.
Remember, the registration page only appears during an online enrollment period that is
open to you. If you don't see a way to get there, then it's not open! Here are the two ways
you can get to the registration page:
a. When you log in to Populi, you'll see an alert on your Home page. Click the alert to
go the registration page.
b. Go to My Profile and click the Registration view.
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c. Selected Courses are those you've registered for (or hope to).
d. Courses Offered are those for which you may submit an enrollment request. The
courses you see here depend on your selections from the drop-downs:
● Enroll/Audit: Toggle between courses you can enroll in or audit.
● Show Available courses with no conflicts: These are courses that match your
program and campus and for which you've fulfilled the prerequisites (or are
currently enrolled in a prerequisite, corequisite, or equivalent) and with which
you have no schedule conflicts. Additionally, if there is a term max enrollment
limit, it shows courses which fall within that constraint.
● Show Available courses: These courses include the above together with
courses that have schedule conflicts and max enrollment conflicts.
● Show All courses: This shows every course offered in the term, whether or not
you can register for it.
e. Each course includes important details:
● Name, faculty, and schedule.
● Whether the course is available for enrollment and/or auditing, how many
openings, and credits/hours.
● Conflicts appear in red: schedule, prerequisites, and term max enrollment
constraints.
● If you've already passed this course, you'll see a notice that she's already
passed it. This does not prevent you from registering for that course.
f.
lets you register for that course.
g. lets you request a spot on the course waiting list.
h.
means that you cannot register for this course because of a conflict with
schedule, enrollment limits, or unmet prerequisites.

10.3. Registering for course
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1. Using the drop-downs, choose whether you want to see courses to Enroll in or Audit
and which Offered Courses you'd like to see (Available..., etc.).
2. Click
next to the course you'd like to add. Click
to request a spot on the course
waiting list.
3. Review the details in the enrollment request and click Add to confirm. A few things
will happen when you do this:
● The course will be added to Selected Courses with an "Unsaved" badge. A
notice will display above Selected; you can either Save the registration
changes or Undo them.
● Offered Courses will switch back to show Available Courses. In all likelihood,
new schedule and max enrollment conflicts will appear.
● If you enroll in a course that requires enrollment in a corequisite course, you'll
be asked to also add the corequisite to Selected Courses.
● If you've made a mistake, click to remove the course.
4. Repeat the above steps as often as necessary.
5. When you're ready to submit the changes, click Save.
After you save your registration, the following may also happen:
● You may be asked to sign an enrollment agreement (see below).
● Tuition, fees, and other charges may be generated for you on My Profile >
Financial > By Term.

10.4. Dropping a course

To drop a course you've
already registered for:
1. Find the course you'd like to drop under Selected Courses.
2. Click
to remove the course.
3. Confirm your choice(s) and then save the changes.

11. Zoom Meetings
All of your face-to-face interaction with your professor in online classes will be held in the
program called Zoom. Before your first Zoom session, please download the program by
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going to https://zoom.us and click on “SIGN UP FREE” in the upper right corner.
Once you have inserted your email, Zoom will send you a confirmation email. You must go
into that email to confirm your account before you can use the program. Once you have
activated your Zoom account, go ahead and log in at least a few hours before your first
class so that you can set up your account. Insert your basic information (you need to scroll
down when you first go into Zoom for the first time. You can also insert your photo so that
when you are in a meeting, this will help to prove your participation because your picture will
be displayed if your internet connectivity is unstable during the meeting.
Once your professor has scheduled a Zoom meeting, he/she will add the link to your online
classroom, which will contain the Meeting ID. Click on the “JOIN A MEETING” button to
come to the screen where you can insert the link or the meeting ID. Remember, if you don’t
sign in before joining a meeting, your photo and name won’t show up.
When you first log into a Zoom session, and if no one else is in the room or started their
video, the screen will be white with a few icons. Be sure to remember to mute your
microphone if you are not speaking.

Clicking the “Chat” button allows you to see what students may be saying and where you
can write something.
Clicking the “Share Screen” button allows you to share your screen or a document. If you hover
your cursor over your name, you can raise your hand.
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Appendix A: Grading Rubric
Your professor will be looking for specific elements in all of your work. Here is a brief outline
that explains exactly what is expected of you.
Theological
Needs Improvement Unacceptable 80Excellent
Good
Reflection
85-90
95-100
90-95
85
Student’s
A clear statement of
The thesis or main
The thesis or main There is no main
observations the main thesis or purpose is obvious, but purpose is present,
purpose.
main purpose of the there is no single clear
but must be
statement of it.
uncovered or
section.
reconstructed from
the text of the paper.
Premises
Each reason for
The premises are all The premises must be
There are no
believing the thesis is clear, although each may reconstructed from
premises; the
made clear, and as
not be presented in a the text of the paper. student merely
It is not made clear
much as possible,
single statement. It is
restates the
presented in single also pretty clear which which premises are to purpose. Or, if
statements. It is also premises are to be taken be taken as given, there are premises,
and which will be
they are much
clear which premises as given, and which will
supported
by
submore likely to
be supported by subare to be taken as
arguments. There are be false than true.
given, and which will
arguments.
be supported by sub- The paper provides sub- no sub-arguments, or,
if there are subarguments.
arguments for
arguments, the
The paper provides controversial premises. If
sub-arguments for there are sub-arguments, premises for these
controversial
the premises for these are not made clear.
The paper does not
are clear.
premises. If there are
provide subsub-arguments, the The premises which are
arguments for
premises for these
taken as given are at
controversial
least plausibly true.
are clear, and made
premises.
in single statements.
The plausibility of the
The premises which
are taken as given
premises which are
taken as given is
are at least plausibly
questionable.
true.
Analysis
Needs Improvement Unacceptable 80Excellent
Good
(Critical
85-90
95-100
90-95
85
Thinking)
The premises clearly The premises support the
The premises
The premises do
Support
support the thesis, thesis, and the author is somewhat support
not support the
and
the thesis, but
thesis.
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Critique

the author is aware
aware of the general
of exactly the kind
kind of support they
of support they
provide. The argument
provide. The
is either valid as it
argument is either
stands, or, if invalid,
valid as it stands,
the thesis, based on
or, if invalid, the
the premises, is likely
thesis, based on
to be or plausibly true.
the premises, is
likely to be or
plausibly true.
The student clearly The student understood
understood the key
the key information,
information, main
main points and facts
points and facts
and articulated a viable
and clearly
critique of the material.
articulated a viable
critique of the
material.

Views

The student was
The student was able
clearly able to
to understand the
understand the
various viewpoints and
various viewpoints
implication of
and implication of speakers, authors, etc.
speakers, authors,
and interact with the
etc. and interact
material.
with the material.

Contextual
Application

Excellent
Good
95-100
90-95
Student applied what Student indicated some
was learned clearly areas of application to
his/her context.
and concisely to
his/her context.

Application

Technical
Quality
Mechanics

Clarity

Excellent
95-100
No errors in
mechanics (spelling,
grammar,
punctuation)

Good
90-95
Several errors in
mechanics

the author is not
aware of the kind of
support they
provide. The
argument is invalid,
and the thesis,
based on the
premises, is not
likely to be or
plausibly true.
The student
The student did not
somewhat
understand the
understood the key
key information,
information, main
main points and
points and facts and facts and did not
somewhat
articulate a viable
articulated a viable
critique of the
critique of the
material.
material.
The student was
The student was
somewhat able to
not able to
understand the
understand the
various viewpoints
various
and implication of
viewpoints and
speakers, authors,
implication of
etc. and interact
speakers,
with the material.
authors, etc. or
interact with the
material.
Needs Improvement Unacceptable 8085-90
85
Very little discussion No application to
about how the
student’s context
material learned
was included.
will be applied to
student’s context.
Needs Improvement Unacceptable 8085-90
85
Many errors in
Too many errors in
mechanics
mechanics to be
considered
graduate-level
work.

All words are chosen Most words are chosen Words are not chosen Student does not
for their precise
for their precise
for their precise
acknowledge that
meanings. All new or
meanings.
meanings. New or
key words have
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unusual terms are
unusual terms are precise meanings.
Most new or unusual
well defined. Key
Information
terms are well-defined. not well-defined. Key
concepts and
(names, facts,
concepts and theories
Key concepts and
theories are
etc.) is inaccurate.
are not explained.
theories are explained.
accurately and
Examples are not
Examples are clear.
completely
clear. Information
Information (names,
explained. Good,
facts, etc.) is accurate. (names, facts, etc.) is
clear examples are
mostly accurate.
used to illuminate
concepts and
issues. Information
(names, facts, etc.) is
accurate.
General
Excellent use of APA Appropriate. Followed Fair. Does not always Does not follow
APA style and paper
academic
Presentation
style. Followed
follow APA style.
template.
guidelines
or the
appropriate paper
paper template.
template.
Research
Quality
Course
materials

Excellent
95-100
Extensive and very
appropriate use of
references to course
materials.

Outside
references

Extensive and very
appropriate use of
outside materials.

Needs Improvement Unacceptable 80Good
85-90
90-95
85
Extensive and
Some references to Minimal references
appropriate
to course
course materials.
materials.
use of references to Only a fair use of APA
Did not follow APA
style
course materials.
formatting for
Footnotes and
footnotes or
bibliography adhere to
bibliography.
APA or style.
Extensive and
Some references to Minimal references
appropriate use of
outside materials.
to outside
outside materials.
materials.
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